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COPYRIGHTS AND TRADEMARKS  

MicroSurvey Tracker Xtreme is a trademark of MicroSurvey Software Inc. 

Microsoft, Windows CE 5.0, Windows NT, Windows 2000, Windows XP, eMbedded Visual C++, Visual 
Studio .NET 2003, Visual Studio 2005 and ActiveSync are either trademarks or registered trademarks of the 
Microsoft Corporation.  

Other products or company names mentioned herein may be the trademarks or registered trademarks of their 
respective companies.  

WARRANTY INFORMATION  

Seller warrants that the product specified in this agreement are free of defects in materials and workmanship, 
and shall conform to the latest specifications published prior to Buyer’s acceptance of the agreement for a 
period of two years.   

Product specifications as defined supersede previous specifications and are complete. Any parameter that is 
not specifically defined in the specifications is expressly excluded from the warranty. This warranty does not 
apply to any product which have been subject to misuse, accident, alteration, or if the unit has been serviced 
by anyone other than an authorized representative of Seller.   

Seller’s sole obligation to Buyer for products failing to meet specifications shall be, at Seller’s discretion, to 
repair or replace the non-conforming device.   

After receiving a Return Authorization (RA) number and a mailing address from Seller, a defective unit 
covered under this warranty may be returned freight prepaid. Any replacement or repaired product shall carry 
only the unexpired term of the warranty plus any the period required for repair.  

If Buyer has been expressly designated as an Original Equipment Manufacturer (OEM) by Seller, the 
warranty period shall commence upon the earlier date of (i) delivery to Buyer’s first customer, or (ii) 180 
days from the original date of shipment by Seller. In the events that products for which: (a) Buyer has title and, 
(b) have never been used, and (c) have been in the Buyer’s possession for more than 180 days and, (d) have an 
unaltered date code attached, may for an established fixed fee which will not exceed ten percent (10%) of the 
original purchase price, have the date code updated by the Seller and thereby reestablish those products with 
a new warranty.  

THE FOREGOING WARRANTY AND REMEDIES ARE EXCLUSIVE AND ARE MADE EXPRESSLY 
IN LIEU OF ALL OTHER WARRANTIES EXPRESSED OR IMPLIED, EITHER IN FACT OR BY 
OPERATION OF LAW, STATUTORY OR OTHERWISE, INCLUDING WARRANTIES OR 
MERCHANTABILITY AND FITNESS FOR USE. MICROSURVEY SOFTWARE NEITHER ASSUMES 
NOR AUTHORIZES ANY OTHER PERSON TO ASSUME FOR IT ANY OTHER LIABILITY IN 
CONNECTION WITH THE SALE, INSTALLATION OR USE OF ITS PRODUCTS AND 
MICROSURVEY SOFTWARE MAKES NO WARRANTY WHATSOEVER FOR PRODUCTS NOT 
MANUFACTURED BY MICROSURVEY SOFTWARE.   

MICROSURVEY SOFTWARE SHALL NOT BE LIABLE FOR DAMAGES DUE TO DELAYS IN 
DELIVERIES OR USE AND SHALL IN NO EVENT BE LIABLE FOR INCIDENTAL OR 
CONSEQUENTIAL DAMAGES OF ANY KIND, WHETHER ARISING FROM CONTRACT, TORT OR 
NEGLIGENCE, INCLUDING, BUT NOT LIMITED TO, LOSS OF PROFITS, LOSS OF GOODWILL, 
OVERHEAD OR OTHER LIKE DAMAGES.   

To maintain your warranty and to avoid creating hazards, only qualified personnel should perform authorized 
modifications to MicroSurvey Software’s products. MicroSurvey Software cannot assume responsibility for 
any condition affecting the proper operation of this equipment that may result from unauthorized 
modifications.  

 
 
 



 

II 

PRODUCT RETURNS  

If, after inspection, you note any product damage or discrepancies, please contact us promptly within five 
days of receipt. If the exterior of the package shows obvious signs of damage, please contact your carrier 
directly.  

All items returned to MicroSurvey Software require a Return Material Authorization number (RMA). Please 
contact MicroSurvey Software’ Service department to request an RMA number.  

REGULATORY NOTICES (PENDING)  

FCC PART 15 CLASS A   
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to 
Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful 
interference when the equipment is operated in a commercial environment. This equipment generates, uses, 
and can radiate radio frequency energy and, if not installed and used in accordance with the instruction 
manual, may cause harmful interference to radio communications. Operation of this equipment in a 
residential area is likely to cause harmful interference in which case the user will be required to correct the 
interference at his own expense.  

This device complies with part 15 of the FCC Rules.  Operation is subject to the following two conditions: (1) 
this device may not cause harmful interference, and (2) this device must accept any interference received, 
including interference that may cause undesired operation.  

FCC ID: RYJJETTXL 
Two Technologies Incorporated 
419 Sargon Way, Horsham, PA 19044 
Phone: 215.441.5305  
 

FCC SECTION 15.21  
Changes or modifications to this unit not expressly approved by Two Technologies may void the user’s 
authority to operate the equipment.  

CANADIAN DEPARTMENT OF COMMUNICATIONS  
This digital apparatus does not exceed the Class A limits for radio noise emissions from digital apparatus set 
out in the Radio Interference Regulations of the Canadian Department of Communications  

CENELEC  

 *  

 *Pending  
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EMI STANDARDS:   
• EN 55022:1998 (CISPR22), Class A  

• ETSI EN 300 330-2: 2001  

EMC STANDARDS:  
• EN 55024: 1998   

• ETSI EN 301489-1: 2002,  301489-3: 2002  

• EN/IEC 61000-4-2, 61000-4-3, 61000-4-4  

WARNINGS  

Changes or modifications to this unit not expressly approved by the party responsible for regulatory 
compliance could void the user's authority to operate the equipment.  

 ELECTROSTATIC DISCHARGE (ESD)  
Electrostatic discharge (static electricity) can have unpredictable adverse effects on any electronic device. 
Although the design of this product incorporates extensive ESD-related precautions, ESD can still cause 
problems. It is good practice to discharge static by touching a grounded metal object before inserting cards or 
connecting devices.  

 SERVICING INFORMATION  
When servicing the unit, the plug (JETT•connect cable) is the disconnect device. Simply unplug the unit 
before servicing.  

 BATTERY REPLACEMENT  
CAUTION! There is a risk of explosion if you replace the NiMH battery with an incorrect type. Only use the 
NiMH battery supplied with your unit or a replacement NiMH battery supplied, recommended, or approved 
by Two Technologies, Inc.  

 BATTERY DISPOSAL  
Dispose of batteries in a safe manner. The following are general guidelines for the safe use and disposal of 
NiMH batteries:  

• Replace a defective NiMH battery immediately as it could damage the unit.  

• Do not throw the NiMH battery it in trash that is disposed of in landfills as it contains heavy metals. Recycle 
or dispose the NiMH battery of it as required by local ordinances or regulations.  

• Do not disassemble, incinerate, short-circuit the NiMH battery or throw it into a fire. It can explode and 
cause severe personal injury.  

• Excessive discharge damages a NiMH battery. Recharge the NiMH battery when your unit indicates low 
battery power.  
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ABOUT THIS MANUAL  

This manual describes the standard features and operation of the Tracker Xtreme. Unless otherwise stated, 
the operational characteristics described herein correspond to factory default configurations and settings as 
shipped from MicroSurvey Software. Wherever used herein, the term “Xtreme” applies to all Tracker Xtreme 
models (except as noted).  

ABOUT THE Tracker Xtreme  

With its modern, ergonomic appearance and design, the TRACKER XTREME is the most recent addition to 
MicroSurvey Software's series of rugged hand held computers for industrial and commercial use. Its quick 
mount connector system allows easy insertion and removal in cradle or vehicle mounts.  

The TRACKER XTREME comes standard with the Windows CE 5.0 operating system and an Intel PXA270 
XScale processor that operates up to 624 MHz. It also has configuration options for, Bluetooth, WLAN, 
GPRS, RS-232, RS-485, RS-422 and USB. WWAN GSM/GPRS are also optionally available  

When you combine the TRACKER XTREME and the JETT•pack, you can integrate GPS, RFID, bar code, 
bar-code scanners, GPRS/GSM, Imagers and cameras.  

TRACKER XTREME FEATURES  

OPERATING SYSTEM   
The TRACKER XTREME uses Windows CE 5.0 as its operating system. You can develop applications 
quickly and easily using the latest development tools and network connectivity from Microsoft, such as  
eMbedded Visual C++ 4.O, Visual Studio .NET 2003 and ActiveSync 3.8.  

RECHARGEABLE BATTERY PACK  
The TRACKER XTREME comes with a rechargeable Nickel Metal Hydride (NiMH) battery pack that can 
provide up to eight hours of operating time on a full charge (depending on power management and use).   

The NiMH technology used in the TRACKER XTREME has exceptional charge life without the “charge 
memory” characteristic of conventional nickel cadmium batteries. Partially discharged batteries or extended 
periods with the charger left connected will not adversely affect battery life or performance. The TRACKER 
XTREME can also run on six AA Alkaline batteries.  

PROCESSOR  
The TRACKER XTREME utilizes an Intel PXA270 processor designed specifically for high-performance, 
low power, portable, handheld devices. It incorporates Intel XScale technology with on-the-fly voltage, 
frequency scaling and sophisticated power management. It also complies with the ARM Architecture V5TE 
instruction set   

MEMORY AND MASS STORAGE  
The TRACKER XTREME comes standard with 128MB of SDRAM (approximately 30MB used for the 
operating system) and 512MB of internal compact flash memory. An additional 256 MB of SDRAM is 
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optionally available. Internal compact flash memory is optionally expandable to 8GB+.   

For removable data storage or I/O cards, the TRACKER XTREME is equipped with a Compact Flash (CF) 
slot.  

DISPLAYS  
The TRACKER XTREME features a supertwist nematic liquid crystal 320 x 240 QVGA-TFT color sunlight 
readable display with touch screen and LED backlight.  

KEYPADS  
Keypad configurations for the TRACKER XTREME include a 52-key elastomeric keypad.  

INDICATORS  
The TRACKER XTREME has five LED indicators that provide a number of useful functions including the 
state of keypad modifier keys. An additional LED indicates the charge and low battery statuses.  

CONFIGURATION OPTIONS  
The TRACKER XTREME comes standard with a RS-232 and a USB port. The TRACKER XTREME also 
includes Wireless LAN (802.11b) and Bluetooth (1.1)   

DURABILITY  
The case is made of General Electric Xenoy, one of the most durable chemical resistant materials available 
today.  

INGRESS PROTECTION  
The TRACKER XTREME is completely dust-tight and can withstand exposure to jets of water and has an IP 
(Ingress Protection) rating of 65 as defined by IEC standard 529.   

Please note, that the product warranty does not cover TRACKER XTREME’s that fail due to electrolysis. 
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FRONT COMPONENTS  

This section describes the components found on the font of the TRACKER XTREME.  

Figure 2-1: Front Components  

   

  

Table 2-1: Front Components and Indicators  

Item  Component  Description  

1  Display   Supertwist nematic liquid crystal display with touch screen  

2  Front Panel  Contains the On/Off switch and modifier keys indicators (see Figure 2-2)  

3  Keypad  45-key keypad shown (other keypads are also available, see Figure 3-9)   
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FRONT PANEL  
This section describes the components found on the font panel.  

Figure 2-2: Front Panel Components  

  

Table 2-2: Front Components and Indicators  

Item  Component  Description  

1  Modifier 
LEDs  

Indicates use of the SHIFT, CTRL, 2ND ALT and CAPS 
modifier keys  

2  Battery LED  Lights red to indicate a low battery or green a charging battery   

3  On/Off Switch  Controls the Power, Suspend and Resume operations  

 

COMPACT FLASH SLOT COVER  

The standard compact flash slot cover located on the top of the unit provides access to the compact flash slot 
that stores memory and device cards. In addition to the standard cover, a modified cover which has a 
machined opening that allows you to easily insert and remove devices cards that exceed 1.437 inches in 
height, is also available.  

Two phillips-head screws+ (2-56 x 5/16”) secure the cover to the top of the JETT. To insert device or 
memory cards into the compact flash slot, you must first remove these screws using a phillips # 0 
non-magnetic tip screwdriver.  

For information about inserting and removing memory and device cards, see Using the Compact Flash Slot.  

Figure 2-3: Standard Compact Flash Slot Cover, Closed  

  

Figure 2-4: Standard Compact Flash Slot Cover, Opened   

  

Figure 2-5: Modified Compact Flash Slot Cover for Long Device Cards  
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TRACKER XTREME•CONNECT SYSTEM  

The XTREME connect system is a set of rugged interface and cable connectors especially designed for 
industrial environments. It features positive connector retention without any hardware restraints for quick 
connect/disconnect operations and a contact design that prevents failure due to pin fatigue and cable stress 
after repeated use.   

DB-9 CONNECTORS  
The DB-9 connectors emulate standard serial pin-out connections, and allow you to connect the XTREME to 
most desktop PCs using a standard null modem cable.  

Figure 2-7: DE-9 Male Interface Connector  

  

RS-232 Interface 
Pin-Outs  

Pin 1 = 
DCD  

Pin 6 = 
DSR  

Pin 2 = 
RXD  

Pin 7 = 
RTS  

Pin 3 = 
TXD  

Pin 8 = 
CTS  

Pin 4 = 
DTR  

Pin 9 = 
11-18VDC 
Input  
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THE POWER/SUSPEND SWITCH  

The On/Off switch is located above the keypad. Its function depends on the state of the XTREME at the time 
the switch is pressed and on the length of time that the switch is depressed. Operations that the Power switch 
can initiate are:  

 Power On  

 Power Off 

 Suspend  

Figure 3-1: Power/Suspend Switch  

  

POWER ON   
To power on the XTREME:   

1) Press and hold the ON/OFF switch for one second. The unit should turn on and begin displaying the 
boot-up process. For example:  

  

Where x.x.x is the version number  

2) After approximately 15 seconds, the Windows CE .NET desktop should appear. If the unit does not 
power up or you cannot select any items from the desktop, refer to the “Troubleshooting” chapter 
for help.  
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POWER OFF  
To turn off the XTREME, press and hold the ON/Off switch for approximately eight seconds. This action 
will also terminate running applications and cease serial port operations).  

SUSPEND MODE  
Suspend mode allows you to suspend, but not terminate active applications. In this mode, the display will 
turn off and the XTREME will cease serial port operations. For battery-powered units, use of Suspend mode 
also conserves battery power.  

To place the unit in Suspend mode, press and release the ON/Off switch.  

To take the XTREME out of Suspend mode, press and release the ON/Off switch again. The display will turn 
on and the XTREME will resume running any suspended application, but you must restart any serial port 
operations.  

If you attempt to resume immediately after suspending the XTREME or vice versa, the unit will 
automatically delay three seconds before resuming or suspending.  

USING THE RECHARGEABLE BATTERY  

The XTREME comes with a rechargeable Nickel Metal Hydride (NiMH) battery pack that can provide up to 
six hours of operating time on a full charge (depending on power management and use). This battery is fully 
charged and installed in the unit when shipped. However, because some battery dissipation occurs between 
the time when the unit ships and when you start using it, you should charge the unit for approximately four 
hours before using it without the battery charger/power supply connected.  

CHARGE/LOW BATTERY INDICATOR  
When using the NiMH battery pack, the CHARGE/LOW BAT LED will indicate the current battery status as 
shown in the table below.  

Figure 3-2: Charge/Low Battery Indicator  

  

Table 3-1: Charge\Low Battery Indicator Functions  

 

Function  Description  

CHARGE  With the power supply connected, the CHARGE/LOW BAT LED will indicate one of 
following conditions:  

 High Power Charge—the LED will turn solid green until the battery reaches 80% capacity of 
its charge capacity  

 Trickle Charge—the LED will blink green about four times a second when the battery 
reaches 80% capacity of its charge capacity  

LOW 
BAT  

With the power supply disconnected, the CHARGE/LOW BAT LED will indicate one of 
following conditions:  

 Batteries are low— the CHARGE/LOW BAT LED will blink red once per second when there 
is approximately 30 minutes of power remaining  

 Batteries are very low—the CHARGE/LOW BAT LED will turn solid red when there is 
approximately 10 minutes of power is remaining  
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Charging the Unit 

The nickel metal hydride battery technology used in the JETT has exceptional charge life without the “charge 
memory” characteristic of conventional nickel cadmium batteries. Partially discharged batteries or extended 
periods with the charger left connected will not adversely affect battery life or performance.  

Note: Because the internal battery charger senses several conditions, including temperature, you should 
charge the unit away from any known or potential heat sources. Units exposed to temperatures in excess of 
110 degrees Fahrenheit during the charge cycle may experience incomplete charging and reduced operating 
time per charge.  

Use of other power supplies unless approved by MicroSurvey Software may cause damage to the unit and 
void the warranty.  

1) Depending on your configuration, plug the power jack of the battery charger/power supply into the 
corresponding cables connector and/or adaptors as shown below.  

Figure 3-3: Using 91708/ 91709, and14375 Cables  

  

2) Plug the battery charger/power supply into a power outlet. The Charge LED should turn on, 
indicating that the batteries are charging (see Table 3-1).   

Figure 3-4: Power Supply  

  

3) Once the battery is fully charged (approximately four hours), you can disconnect the AC power 
supply and run the XTREME exclusively on battery power.  

 
 
 
 
 
 



  Tracker Xtreme 

  9 

REPLACING BATTERIES / BATTERY PACK  

CAUTION! There is a risk of explosion if you replace the NiMH battery with an incorrect type. Only use a 
NiMH battery supplied with your unit or a replacement NiMH battery supplied, recommended, or approved 
by MicroSurvey Software, Inc.  

When using alkaline batteries, replace all alkaline batteries in the XTREME at the same time. Do not mix old 
and new batteries, mix different types or brands of batteries, or dispose of the batteries in a fire. These actions 
can cause battery rupture or leakage that result in personal injury or property damage.  

Remove the batteries from the XTREME when not using the XTREME for extended periods. Store the 
batteries in a cool, dry location at normal room temperature.  

To replace the rechargeable battery pack or change AA batteries:  

1) Turn the power off. With the unit face down, pull the battery cover retaining clip up from its 
recessed slot and turn the clip in a counter clockwise motion (see Figure 3-5).  

2) Lift the cover up and remove the batteries/battery pack.  

3) If the unit contains a NIMH battery pack, use the tab to lift up on the battery pack and then out.  

4) Close the battery cover and turn the battery cover retaining clip clockwise to lock the cover.  

Figure 3-5: Changing Batteries  
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DATA ENTRY  

52-KEY KEYPADS  
This joystick style keypad with bezel nomenclature features easy screen navigation and alphanumeric keypad 
entry and four programmable function keys. Users can also access navigation keys and backlight control via 
the SHIFT key.  

CTRL and ALT Keys—operate in the same manner as on conventional PCs, except that by default they 
have a one-time locking action to facilitate one-handed operation.  

SHIFT Key—unlike conventional PC keyboards, the SHIFT key enables you to access symbols, punctuation 
marks and navigation arrows rather than shift alphabetic keys to uppercase. By default, the SHIFT key has a 
one-time action. However, you can press the Shift key twice and lock the keypad into Shift mode. Pressing 
the Shift key a third time will release Shift mode.  

2ND Key— shifts the numeric keys to corresponding function keys (1 = F1, 2 =F2, etc.) that are found on 
conventional PC keyboards. It also shifts other keys for punctuation, non-printing characters (such as Delete 
and TAB), and PC key definitions (such as Page Up, Page Down, Home, Insert and Caps Lock).   

Like the Shift key, the 2ND key has a default one-time action and a locking mode (i.e., pressing the 2ND key 
twice will lock the keypad into 2ND mode).  

KEY REPEAT  
By default, the XTREME does not automatically repeat a key stroke when you hold down a key. However, 
you can enable the key repeat function by configuring the Keyboard setting in the Control Panel.  

CE KEYBOARD  
In addition to entering data through the keypad, you can also enter data by using the CE Keyboard. This 
utility displays a keyboard on the screen to allow data entry via the Command Line or into applications where 
“text accessibility” control has focus (i.e., text or combo box).  

To use the CE Keyboard, select Programs > Tools> CeKeys from the Start menu.  

   

To minimize the keyboard, click the keyboard icon that appears in the system tray  

Figure 3-11: CE Keyboard  

    

TRANSCRIBER  
Microsoft Transcriber is a natural handwriting recognition software program that interprets pen movement 
across the screen as handwriting (cursive, print or mixed) input. For more information, please refer to 
Microsoft Transcriber Help on the XTREME.  

To run Microsoft Transcriber, select Programs > Tools> Transcriber from the Start menu.  
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Figure 3-12: Transcriber  

  

THE WINDOWS CE DESKTOP  
This section provides a brief overview of the functions that appear on the XTREME desktop. For information 
on how to change desktop settings, refer to Windows CE .NET help (Start > Help).  

Figure 3-13: Windows CE .NET Desktop  

  

 

DESKTOP FUNCTIONS   
You can access the following applications, functions and data entry utilities from the XTREME desktop:  

Table 3-3: Desktop Functions  

Icon  Function  Description  

  

Recycle Bin  Use the Recycle Bin to restore deleted files or empty the bin to create more disk 
space.  

  

My Device  Use My Computer to navigate and view the folders and files stored on the 
XTREME.   

  

Inbox  Use the Inbox to send and receive e-mail by connecting to a POP3 or IMAP4 
server.  

  
My Documents  The default storage location for documents, graphics, and other files.   

  

Microsoft 
WordPad  

Use WordPad to create or edit text files that contain formatting or graphics.   

  

Internet 
Explorer  

Use Internet Explorer to view Web pages. You will need a modem or Ethernet 
card to connect to an Internet service provider (ISP) or network.  

  

PC Link  Use PC Link to make an ActiveSync, Bluetooth or other type of connection to 
another device   
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Media Player  With Windows Media Player, you can view and listen to multimedia files 
(audio playback requires a Bluetooth stereo headset and appropriate service).  

 

THE TASKBAR  

The taskbar at the bottom of the XTREME desktop displays the Start button, buttons of currently running 
applications, the Status Area and the Show Desktop icon.   

Tap the Start button to display the Start menu (see below for details). For each open application, a button 
appears on the taskbar. Simply tap the button to activate the application.  

The status area appears on the right and by default displays small icons for the input panel, current time, 
power status and network connections. Tap an icon to activate the related program.  

Tapping the Show Desktop icon minimizes active applications and redisplays the desktop. Tapping the 
Keyboard icon displays the Input Panel menu for data entry.  

Figure 3-14: Windows CE Desktop Taskbar  

  

 

POWER STATUS ICONS  

The XTREME will display power status icons (Table 3-4) in the taskbar status area (Figure 3-14) to indicate 
power use, charging status and low battery conditions.  

Table 3-4: Power Status Icons  

Icon Description 

 
External AC power supply connected 

 
Batteries are charging 

 
Batteries are low—approximately 60 minutes or less of use remaining (the 
CHARGE/LOW BAT LED will blink red once per second) 

 
Batteries are very low—approximately 10 minutes or less of use remaining 
(the CHARGE/LOW BAT LED will turn solid red) 
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THE START MENU  

When you tap Start, the Start menu appears.   

Figure 3-15: Start Menu  

  

By tapping one of the menu’s icons (and not the name), you can:  

 Open programs that do not appear on the desktop 

 View a list of web sites added to your Favorites List 

 View recently accessed documents and images 

 Access the Control Panel, establish connections, or configure the Taskbar and Start Menu 

 View Help 

 Start an application using the Run command 

MISCELLANEOUS TOOLS  

You can access the following utility programs from the Tools menu.  

SCREEN CAPTURE  
The Screen Capture program takes a picture of the screen and saves it as a bitmap file (.BMP) to a designated 
location. You can set up the program to run from the system tray, or by pressing a hot key.  

To setup the Screen Capture program:  

1) From the Start menu, select Programs > Tools > Screen Capture. The ScreenCapture.exe dialog box 
appears:  

   

By default, the Screen Capture program is set to take a picture by pressing HotKey1 after a 
five-second delay.  

2) To change the wait time before the Screen Capture program takes a picture, tapping the up or down 
scroll bars under Capture Delay (sec). The default value is five seconds.  

3) To change the Keyboard Hot Key assignment, you must access the Hot Key applet in the Control 
Panel. The default value is five HotKey1  

4) To have the Screen Capture program take a picture when you tap its icon in the System Tray, check 
Auto run in the task bar.   
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Note: To deselect this option after making it active, tap and hold the icon until the Screen Capture 
program appears.  

5) To view the picture immediately following the screen capture, check View following capture.  

6) To change the default folder (My Document) where picture are stored, tap the button under Store 
screen capture in folder.  

    

7) Select a new location and tap OK.  

8) By default the Screen Capture program, automatically assigns a number to each screen capture. The 
numbering scheme starts at JET00000 and increment by one after each capture. To set this number 
back to JET00000, check Reset the counter.  

Note: Screen captures stored in folders other than the SystemCF folder will be lost if you remove 
power from the unit.  

Reset Device 

WARM BOOT  
Occasionally, a program may encounter an error from which it cannot recover. In these cases, you can 
perform a warm boot, which will reinitialize the unit without affecting the contents stored in virtual memory.  

To perform a warm boot:  

1) Select Programs | Tools | Warm Boot. The “Are you sure” prompt appears.  

   

2) Tap Yes to warm boot the unit.   

Hard Reset 
To hard reset the MicroSurvey Tracker, press and hold the ON/Off switch between 10 and 15 seconds. The 
screen should turn off, and the boot-up process should start when you press the ON/Off switch. After 
approximately 20-25 seconds, the Windows CE .NET desktop should appear. 

Note: Holding the Power/Resume button longer than six seconds will turn off the MicroSurvey Tracker. 

Note: A hard reset will not erase anything saved in the System CF location on your Tracker. 

The Tracker is set up to create a shortcut to FieldGenius/EVR on the main desktop after a hard reset.    

MANUALLY SAVING THE PERSISTENT REGISTRY  

The XTREME internal memory consists of DRAM and Flash. Typically, any changes made to the XTREME 
including file creation are temporarily stored in the unit’s DRAM. You must then copy the files from DRAM 
to internal flash memory or a removable compact flash card to store the information permanently.   

Consequently, if you do not store the information to flash memory and the unit loses power, all information 
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stored in DRAM will be lost. However, whenever you make changes that affect the registry, such and 
changing settings in the Control Panel or installing software, you can permanently store registry changes 
without writing to flash memory by using the Persistent Registry.   

Note: The XTREME will also store registry information every time you perform a suspend/resume 
operation.  

To store registry information on the XTREME permanently:  

1) From the Start menu, select Programs | Tools | SaveReg.  

2) The XTREME will begin saving the registry.  

   

3) After you successfully save the registry, a message box will appear:  

   

4) Tap OK to close the message box.  

RESETTING THE REGISTRY 

To reset the Windows CE .NET registry back to the factory default settings: 

1) Turn off the MicroSurvey Tracker and hold the power button for 10 seconds.  

2) Release the power button 

3) Press and release the power button to start the reboot process. 

4) This step is important.  As soon as you release the power button in step 3, you then have to hold 
down the “Windows Key” and “Caps” keys, or the “A” and “I” keys (depending on which keypad 
your Tracker has, see below) and continue holding them until the white reboot screen appears. 

                 
5) When the white screen appears, you can release the two keys. 

6) If you are successful, the screen will display version information, followed by “Invalidating 
Persistent Registry,” before it completes the boot up process: For example: 

  

Where x.x.x is the version number 

*****       JETT.ce        ***** 
Loader Ver x.x.x 
Invalidating Persistent 
Registry 
Booting from System Socket 
Loading CE image... 
#################  

Press 
these two 
keys 
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COMMAND PROMPT WINDOWS  

The command prompt window allows you to execute limited MS-DOS command line arguments (e.g., CD 
SystemCF, Run TEST.BAT, etc.).  

To open the Command Prompt window:  

1) From the Start menu, select Programs > Tools> Command Prompt. The Command Prompt window 
opens:  

   

2) You can then type in your commands. For a list of supported commands, type Help and press Enter.  

3) To end the session, type Exit and press Enter.  

SYSTEMCF FOLDER   

The only folder that provides non-volatile (permanent) storage is the SystemCF folder. Information stored in 
other folders will be lost when you remove power from the XTREME. You can however, have the XTREME 
automatically copy files from the SystemCF to other folders when booting up.   

USING THE COMPACT FLASH SLOT  

The Compact Flash Slot located on top of the XTREME enables you utilize a variety of devices such as 
memory cards, barcode scanners, GPS cards and network cards.  

If you intend to use a device card, it may also be necessary to install a driver. If so, make sure the card is 
Windows CE 5.0 compatible and you have the necessary drivers. If you are not sure, check with the card 
manufacturer before attempting to install the card.  

To use the compact flash slot:  

1) If needed, remove any screws from the cover to access the Compact Flash slot. Refer to the 
“Compact Flash Slot Cover” section for information about cover and screw types.  

2) With the front of the display facing you, push the compact flash slot cover to the left. The slot cover 
will automatically pop open. If the cover has a slot, you can skip this step.  

3) Insert the compact flash/device card into the slot with the front of the display facing you and the top 
of the card pointed to the slot until it clicks and the release lever moves upward.  

Figure 3-16: Using the Compact Flash Slot  
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4) Close the cover.   

5) When inserting memory cards, a “UserCF” folder will appear when you open My Computer. You 
can then copy and paste the contents of UserCF to the other folders on the XTREME.  

6) When inserting device cards, the XTREME will attempt to recognize the device. If it finds a driver 
for the device, the XTREME will display a dialog box for that device. For example:  

   

7) If the XTREME cannot find a driver for the device, it will display the following dialog box:  

   

8) If the correct card type appears, you can enter the appropriate information in the dialog box and then 
tap OK to complete the installation.  

9) To remove a card from a slot, simply push the card release lever down and remove the card.   
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THE CONTROL PANEL   

The table below lists the available control panel functions on the XTREME.  

Table 4-1: Control Panel Functions  

Icon  Function  Description  

  
Aux CF Card  This function enables you to enable/disable power to CF 

cards installed in the internal CF Card slot, which not user 
accessible.  

  

Aux Switch  For units with a second COM that supplies 5VDC output, 
use this function to set the default power state (On or Off), 
and test the connected devices.  

  
Backlight  Use this function to adjust the backlight setting for the 

following conditions: Line Active, Line Active Inactive, 
Battery Active and Battery Inactive.  

  

Battery Select  Select one of the following options to calibrate the power 
status icons for proper use: NIMH, AC Line or Alkaline.  

  
Beep Select   Use this function to change the frequency, volume and 

duration properties of the beep.  

  

Certificates  Use this function to import, view or remove certificates, 
which protect your personal information on the Internet, 
and protect your computer from unsafe software.   

  
CPU Speed  Use this function to determine the current CPU and cold 

boot-up speed. Allowable selections are 312 MHz and 624 
MHz).  

  

Date/Time  Use this function to adjust the date, time and time zone.  

  

Dialing  Use this function to adjust the dialing location settings and 
dialing patterns when using a modem.  

  

Display  Use this function to adjust the backlight timeout, change 
the background image or change the desktop color 
scheme.  

  
Display Rotation  Use this function to rotate the screen 180 degrees (upside 

down).  

  
Hot Keys  Use this function to assign functionality to the unit’s eight 

programmable keys.  
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Internet Options  Use this function to set up connections, security settings 
and internet related functions.  

  Keyboard  Use this function to change the repeat delay and repeat 
rate.  

  

Network and  Dial-up Connections  Use this function to change network adapter settings 
and/or set up identification for remote networks.  

  
Owner  Use this function to enter the owner name, address, phone 

numbers, notes and network ID.  

  

Password  Use this function to enable password protection and set a 
password.  

  

PC Connection  Use this function to enable direct connection to a desktop 
computer  

  
Power  Use this function to:  

 Check battery power  

 Set device to turn off when idle  

 Set up power schemes  

 Check the power levels of your system devices  

 

  

Regional Settings  Use this function to change the appearance of region 
specific information, such as date, time and currency.  

  

Remove Programs  This function enables you to remove programs installed in 
RAM.   

  

Stylus  Use this function to recalibrate the touch screen and adjust 
the stylus double-tap rate.  

  

System  Use this function to view system information, change the 
RAM (Program/Storage memory) division, change the 
device name and change the device description.  

  
VComAdj  Use this function to minimize screen flicker and adjust 

contrast.  

 

POWER MANAGEMENT  

Battery-powered units can utilize a rechargeable Nickel Metal Hydride (NiMH) battery pack that has an 
average operating time of four hours on a full charge with power management and approximately six hours 
without power management. As with all battery-powered devices, the operating time is completely 
dependent on the environment, device usage and the number and type of power-drawing peripherals attached. 
The battery discharge rate in a full “Power Off” state is only slightly higher to the self-discharge rate of the 
battery itself.  

Note: Allowing the batteries to remain in a low or very low condition will cause the unit to enter Suspend 
mode. In either case, you should save your work and recharge the unit as soon as possible  

To lengthen the time between charges, you can perform the following actions:  

 Use external power for PC Card operations whenever possible— some PC Cards as well as 
extended communication via the serial port, may require large amounts of power to operate, and can 
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quickly drain the batteries.  

 Limit the use of backlight—minimize backlight use when you are operating on battery power. You 
can adjust the backlight timeout level through the Display Settings in the Control Panel or on some 
units by using the keypad.  

 Shorten Auto-suspend time—the XTREME is automatically set to suspend operation to conserve 
battery power when you have not used the keyboard or the stylus after three minutes. You can 
increase the Auto-suspend time by changing the Power settings in the Control Panel. 

 Disable WIFI and Bluetooth communications if they are not being used. 

TASKBAR AND START MENU SETTINGS  

To change the Taskbar and Start Menu settings:   

1) Select Start > Settings> Taskbar & Start Menu. The Taskbar and Start Menu Properties dialog box 
opens:  

2) Select the General tab:  

   

3) Check Always on Top to ensure that the taskbar is always visible, even when a program appears in a 
full window (maximized).  

4) Check Auto hide to display the taskbar just when you point to the taskbar area.  

5) Check Show Clock to display the time of day in the taskbar.  

6) Select the Advanced tab:  

   

7) Tap the Clear button to remove the contents of the documents menu.  

8) Check the Expand Control Panel box to display the contents of the Control Panel as items on the 
Settings| Control Panel menu.  

9) Tap OK to save the settings and exit the menu.  

NETWORK CONNECTIONS  

You can connect directly to a network to access e-mail, access files available on a network server or browse 
the Interne via the TRACKER XTREME’s integrated Bluetooth or internal WLAN options. You can also 
connect directly to a network using one of the following approved card:  

 Socket Low Power Wired Ethernet CF Card   

 Socket Low Power Wireless LAN CF Card (U.S.A. or International)  

Note: If you are using communications cards other than those supplied by MicroSurvey Software, you will 
need to ensure that the card manufacturer supports Windows CE 5.0.  
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CREATING A WIRED ETHERNET NETWORK CONNECTION  

To create a Wired Ethernet connection:  

1) Insert the Ethernet card into the XTREME and connect the cable to the network.   

2) Select Start > Settings > Control Panel. Double-tap Network and Dial-Up Connections.   

3) Double-tap the connection icon for the adapter. For example, if you have a NE2001 Ethernet adapter, 
double-click the NE2001 connection icon.  

4) In the Ethernet Driver Settings dialog box, select Obtain an IP address via DHCP and tap OK.  

   

5) If prompted, enter the User Name, Password, and Domain name used to log on to your network.   

CREATING A WIRELESS CONNECTION  
To create a wireless network connection, using an approved wireless card or integrated option, refer to either 
the TRACKER XTREME Wi-Fi Setup and Configuration Guide or the TRACKER XTREME Bluetooth 
Setup and Configuration Guide.  

SETTING UP IDENTIFICATION FOR REMOTE NETWORKS  
To set up identification for remote networks:  

1) Select Start > Settings > Control Panel.   

2) Double-tap Owner.   

3) In the Network ID tab, enter the user name, password, and domain name you use to log on to the 
remote network.  

   

CONNECTING TO A MAIL SERVER  
You can send and receive e-mail by connecting to a POP3 or IMAP4 server. Inbox contains an e-mail service 
for each method you use. For either service, you must establish a connection to your Internet service provider 
(ISP) or to the appropriate mail server in your local area network. In addition to creating this connection, you 
must also create the e-mail service.   

Prior to setting up a service, you should obtain the following information from your ISP or network 
administrator: POP3 or IMAP4 server name, SMTP host name, user name, password and domain name (for 
network connections only).  
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Notes: Windows CE .Net does not support other mail protocols such as AOL or services that use special 
authentication, such as MSN. However, you can gain access to the Internet through these services. If you use 
the same service to connect to different mailboxes, set up and name a different service for each connection. 
For additional information about the inbox, refer to Windows CE .NET online help.  

To connect to your POP3 or IMAP4 mail server:  

1) Select Start > Programs > Inbox > Services > Options. The Options dialog box opens.  

   

2) Select the Services tab and tap Add. The Service Name dialog box opens.  

   

3) From the Service type list, select POP3 Mail or IMAP4 Mail.   

4) Enter a unique name for the service (you cannot change this name once entered).  

5) Tap OK. The Mail Service Setup wizard appears.  

   

6) In the Required panel:  

Select the name of the connection you created to connect to the mail server. If you are receiving 
e-mail through a network (Ethernet) connection, select Network Connection.   

If you want Inbox to use your current connection, select (none).   

If you have not created a connection, select Create new connection, double-tap the Make New 
Connection icon, and follow the instructions in the wizard. When finished, select Inbox in the 
Taskbar and continue setting up Inbox.   

Enter the POP3 Host or Server (IMAP4) name of the mail server you use to receive and send 
messages.   

Enter the User ID (user name or mailbox ID) assigned to you.   

Enter the Password you will use to access this mail account. If you do not want a prompt to enter the 
password each time you connect, select Save password.   

7) In the Optional panel:  

If connecting to a network that uses Windows NT domain security, enter the Windows NT domain 
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name.   

If your mail service uses a separate server for SMTP, enter the SMTP Host name. For POP3 Mail 
service with an ISP, the ISP must use an SMTP mail gateway.   

Enter your return e-mail address.  

8) Tap Next. The General Preferences dialog box opens.  

   

9) Choose any of the settings, all of which are optional, then click Next. The Inbox Preferences dialog 
box opens.  

   

10) Choose any of the settings as needed, then click Finish. The Mail Service Setup wizard closes and 
the Options dialog box reappears.   

Note: Receiving entire messages consumes storage memory.  

11) Close the Options dialog box to return to the Inbox. .  

CREATING AN ACTIVESYNC CONNECTION  

ActiveSync is a desktop utility program (available as a free download from Microsoft) that allows you to 
synchronize certain types of information between a PC and the XTREME. You can also use ActiveSync to 
transfer files and install programs on the XTREME.   

When connecting the XTREME to the PC via ActiveSync, you can opt to create a partnership and 
subsequently have the PC automatically recognize the XTREME and synchronize information. You can also 
create a temporary Guest partnership to copy files and install programs.  

The following procedures describe how to make an ActiveSync connection using a serial interface cable. For 
information on how to make an ActiveSync connection using Bluetooth or Wi-Fi, refer to the appropriate 
manual.  

INITIAL COMMUNICATION (Serial) 
To setup initial communication between the PC and the XTREME using a serial connection:  

1) Connect an interface cable to an available COM port on the PC and the XTREME’s RS-232 port.  

2) On the PC, start ActiveSync.  
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3) On the ActiveSync menu bar, select Connection Settings from the File menu. The Connection 
Settings dialog box opens.  

    

4) If not selected, check the Allow serial cable or infrared connection to this COM port box, and assign 
the number of the available COM port (typically COM1).  

5) Click OK to exit.  

6) On the ActiveSync menu bar, select Get Connected from the File menu. ActiveSync will then start 
the Get Connected wizard.  

   

7) Click Next. ActiveSync will start attempting to establish a connection (this process will take several 
seconds).  
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8) On the XTREME, tap PC Link.   

   

9) The following message box appears:  

   

If you don’t see “Connecting to PC-115” in the dialog heading, you need to go to Start | Settings | 
Control Panel.  In the Control Panel, find the PC Connection icon and open it.  In the PC Connection 
Properties dialog, press the Change Connection button to select PC-115K. You will need to start 
over at step 6. 

10) If ActiveSync successfully establishes communications, the ActiveSync dialog will briefly reappear 
on the PC and start the New Partnership dialog wizard.  

   

11) Select your Partnership option as needed and complete the wizard. The ActiveSync dialog box will 
reappear and display a status of “Connected.” For example:  
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Note: When creating a partnership, the XTREME will only synchronize files, other information 
types, such as Inbox, tasks and calendar are not supported.  

12) On the XTREME, an icon indicating a ActiveSync connection will appear in the system tray.   

   

13) To terminate the ActiveSync connection, double-tap the connection icon to display the Connect to 
PC-115K dialog box and tap Disconnect.  

   

INITIAL COMMUNICATION (USB) 
To setup initial communication between the PC and the XTREME using a USB connection:  

1) Connect an interface cable to an available USB port on the PC.  Do not connect it to the XTREME’s 
USB port.  

2) On the PC, start ActiveSync.  

   

3) On the ActiveSync menu bar, select Connection Settings from the File menu. The Connection 
Settings dialog box opens.  
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4) If not selected, check the Allow USB connection with this desktop computer  

5) Click OK to exit.  

6) On the ActiveSync menu bar, select Get Connected from the File menu. ActiveSync will then start 
the Get Connected wizard.  

   

7) Click Next. ActiveSync will start attempting to establish a connection (this process will take several 
seconds).  
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8) On the XTREME, connect the USB cable to the available USB port. 

9) The following message box appears:  

   

If you don’t see “USB_Serial” in the dialog heading, you need to go to Start | Settings | Control 
Panel.  In the Control Panel, find the PC Connection icon and open it.  In the PC Connection 
Properties dialog, press the Change Connection button to select USB_Serial.  You will need to start 
over at step 6. 

10) If ActiveSync successfully establishes communications, the ActiveSync dialog will briefly reappear 
on the PC and start the New Partnership dialog wizard.  

   

11) Select your Partnership option as needed and complete the wizard. The ActiveSync dialog box will 
reappear and display a status of “Connected.” For example:  

   

Note: When creating a partnership, the XTREME will only synchronize files, other information 
types, such as Inbox, tasks and calendar are not supported.  
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12) On the XTREME, an icon indicating a ActiveSync connection will appear in the system tray.   

   

13) To terminate the ActiveSync connection, double-tap the connection icon to display the Connect to 
PC-115K dialog box and tap Disconnect.  

   

 

SUBSEQUENT COMMUNICATION  

After you install ActiveSync and establish the initial communication between the PC and the XTREME, use 
the following procedure to set up subsequent sessions:  

1) If not already attached, connect an interface cable to an available COM port or USB port on the PC 
and the RS-232 port or USB port on the XTREME.  

2) On the XTREME desktop, tap PC Link to attempt to reestablish communications if connecting via a 
serial connection.  If using USB, communication should start automatically when the USB cable is 
connected to the XTREME. 

3) If you have setup a partnership, the XTREME will automatically reconnect and attempt to 
synchronize any files.  

If you have not setup a partnership, the New Partnership wizard will appear.   

   

4) Select No on the PC and then click Next. A status of “Connected” should appear in the ActiveSync 
window.  
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CREATING A REMOTE PC LINK ACTIVESYNC CONNECTION  

When a wired Ethernet or Wi-Fi card installed on your XTREME, you can connect to a LAN (local area 
network) to synchronize or copy files.  

To make a remote PC link:  

1) Set up a partnership, between the XTREME device and your desktop computer using a serial 
connection.  

2) In ActiveSync, enable the network (Ethernet) connection.  

3) On the XTREME, insert an approved wired Ethernet or Wi-Fi card into the CF slot. A network 
connection icon should appear in the system tray.  

4) Tap the network connection icon in the system tray to establish a network connection on the 
XTREME.  

5) After making a connection, tap Start and then select Programs > Communications > PC Link 
Remote. The ActiveSync dialog box appears.  

   

6) From the Connect to drop down list, select the PC name g. The XTREME will then establish a 
connection and automatically synchronize the files in your computer’s desktop folder.  

      

7) Tap Sync Now to update your folders manually.   

8) Tap Disconnect to terminate the connection.  
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Troubleshooting 

MY XTREME DOES NOT RESPOND WHEN I PRESS THE POWER BUTTON.  
 Is the unit in Suspend mode?  

 If battery-powered, check the batteries.  

 Are all cables connected properly:  

  Is the power supply plugged into an active AC outlet?  

  Is the power connector securely plugged into the XTREME?  

I CHANGED MY SYSTEM SETTINGS, BUT WHEN I TURN ON THE XTREME, MY 
SETTINGS ARE GONE.  

 You must save the registry after making any system or configuration changes.  

I TRANSFERRED FILES TO THE XTREME FROM MY HOST COMPUTER, BUT 
WHEN I TURN ON THE XTREME MY TRANSFERRED FILES ARE MISSING.  

 To store transferred files permanently, you must file copy the files into internal flash memory or a 
compact flash card.   

 Occasionally, transferred files can be hidden from view, double-tap My Computer, select Options 
from the View menu and clear all boxes.  

THE XTREME ACTS SLOWLY.  
 The unit may be short of program memory or storage memory.  

 Increase the amount of storage or program memory through the System control in the Control Panel.  

 You can also delete any unnecessary files.  

I GET LITTLE OR NO SOUND FROM THE XTREME.  
 Adjust the volume and sound properties via the Volume and Sound control in the Control Panel.  

THE XTREME DOES NOT RECOGNIZE A COMPACT FLASH OR DEVICE CARD.  
 The card is not installed or seated properly. Reinstall the card. There may be an unstable connection 

between the card and the XTREME.  

 Remove the card, clean the edge connector with a soft dry cloth, and reinstall the card.   

THE XTREME GOES INTO AUTO-SUSPEND AFTER A SHORT PERIOD OF 
INACTIVITY.  

 As a default, the device will auto-suspend after two minutes of inactivity while running on batteries 
and after thirty minutes of inactivity when running on AC power.  
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 Adjust the power management properties via the Power control in the Control Panel.  

I CANNOT CONNECT TO THE DESKTOP USING ACTIVESYNC 
 Do you have ActiveSync installed? 

 Check the cable connection between the Xtreme and your computer. 

 Check serial or USB connection settings on the Xtreme. 

 In ActiveSync, check the Connection Settings for the connection type you are using (USB, Serial or 
Ethernet) 

THE SCREEN IS TOO LIGHT OR TOO DARK 
 Adjust the brightness via brightness control in the Control Panel. 

THE STYLUS DOESN’T RESPOND PROPERLY. 
 The screen is not calibrated correctly to interpret the screen taps. You need to recalibrate the screen. 
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Appendix A - Specifications 

POWER   
 Recharge/Line-Power: 11 to 18 VDC, 1.2A   

 Standard: Input at 11 to 18 VDC via XTREME connect system interface for line-power or battery 
charging operations  

 Optional: Output at 5 VDC @ 1.2A to operate peripheral devices (either port)  

 Rechargeable Battery Type: Nickel Metal Hydride (or 6 AA alkaline batteries)  

 Current Rating: 2 Amp Maximum  

 Voltage: 7.2 Volts  

  Capacity: 2500 mAh  

DISPLAY  
 Supertwist Nematic Liquid Crystal TFT Touch Screen with white LED backlight  

 Resolution: 320 x 240 pixels QVGA color   

CPU  
 Type: Intel PXA270 processor   

  Speed: up to 624 MHz  

  Operating System: Windows CE 5.0  

MEMORY AND MASS STORAGE   
 SDRAM: 128 MB (256 MB optional)  

 Internal Compact Flash: 512 MB standard (30 MB reserved for OS), upgradeable to 2 GB  

 Optional: Compact flash card slot  

USER INPUT   
 Touch Screen  

 Key Pad: Choice of 52-key joystick style elastomeric keypad,  45-key elastomeric keypad (9 rows x 
5 columns), 30-key elastomeric keypad (10 rows x 3 columns), 15-key elastomeric (5 x 3), or 
45-yey membrane (9 rows x 5 columns)   

 Feedback: Tactile and audible  

 Optional: LED backlighting  

INDICATORS   
 5 Modifier Key/Programmable LEDs  

 Charge/Low Battery Indicator  (battery-powered units only)   

CONNECTIVITY  
 Standard: XTREME•connect serial port with choice of full RS-232 or a choice of two of the 

following: short RS-232 (2), short RS-422, short RS-485 or USB.  

 Optional: Bluetooth (Class 1 or 2) ,Wi-Fi (802.11b) or GPRS  
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ENVIRONMENTAL  
 Operating Temperature: -20°C to +50°C  

 Storage Temperature: -20°C to +70°C   

 Charging Temperature: -20°C to + 40°C   

 Humidity: 5-95% Non-condensing  

 IP Rating: 65  

PHYSICAL DIMENSIONS  
 Height (H): 9.84 Inches (250 mm)  

 Width (W): 4.75 Inches (120.7 mm)  

 Depth (D): 1.83 Inches (46.5 mm)  

 Weight with NiMH Batteries: 29 Ounces (822 grams)   

 Weight with Alkaline Batteries: 28 Ounces (794 grams)  

 Weight without Batteries: 23 Ounces (652 grams)  

Figure A-1: Case Dimensions  
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Appendix B – FieldGenius/Evidence Recorder Information 

Installation 
All Tracker Xtreme units shipped from our office are shipped with FieldGenius or Evidence Recorder 
already installed; you do not need to install it from the CD shipped with the Tracker.   

Transferring Files 
To transfer files between your Tracker and your computer, you will need to install Microsoft ActiveSync.  
ActiveSync is available as a free download from Microsoft’s website, or it can be installed directly from the 
FieldGenius or Evidence Recorder CD that is included with the Tracker.  On Page 26 of this manual, you will 
find detailed information about how to make a connection between your Tracker and your computer. 

If you need to install ActiveSync from the FieldGenius or EVR CD, simply follow these instructions: 

1) Put the CD in your CDROM drive. 
2) On the main install screen, press Install. 
3) In STEP 1 of the install screen, press the “Install 4.2 here first” link to install ActiveSync. 
 

MicroSurvey Transfer 
To help you transfer files and projects back and forth, you can install our MicroSurvey Transfer program.  
The Transfer program helps you define specific locations on your computer’s hard drive where you always 
want to download your Evidence Recorder scenes to.  The Transfer program can also automatically find your 
FieldGenius or Evidence Recorder projects on your Tracker Xtreme. 

To learn how to use the Transfer program, once it is installed you can go to the help menu and open the help 
file.  In there you will see instructions on how you can watch a short movie about the Transfer program. 
 

Running FieldGenius or Evidence Recorder for the First Time 
To run FieldGenius or Evidence Recorder, all you need to do is find the FieldGenius or EVR icon on the 
Tracker Desktop.  Simply double tap this icon to start the program.  Normally FieldGenius or Evidence 
Recorder is shipped from our office in an unregistered state so when you run the program for the first time, 
you will see the registration screen. 

You will need to call 800-668-3312 and tell us what your machine id is.  MicroSurvey will then issue you a 
key code that will license your copy of FieldGenius or Evidence Recorder. 
 

Getting Help 
FieldGenius and Evidence Recorder have a built in help system.  On most dialogs, you can tap the help button 
at the top right corner of the screen to open our help system. 

If you didn’t find an answer to your question, you can always call our technical support line at 800-668-3312. 
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Appendix C – Bluetooth Configuration 

ABOUT BLUETOOTH  
Named after a tenth-century Danish king that united Denmark and Norway, Bluetooth is a worldwide 
standard for the wireless exchange of data between two devices. Typical uses of Bluetooth include:   

• File Transfer  

• Local Area Network access  

• Object exchange between computers (OBEX)  

• Serial port emulation  

• File system synchronization  

Bluetooth technology utilizes a radio link that operates in the unlicensed Industrial Scientific and Medical 
(ISM) 2.4GHz band to transmit data at speeds up to 721 Kbps. The effective range between devices is 
dependent on class. Class 1 devices have a range of approximately 100 meters; Class 2 devices have a range 
of approximately 10 meters.  

Bluetooth technology also employs a Frequency Hopping Spread Spectrum (FHSS) scheme to make the 
connection robust and operate in a noisy radio frequency environment. FHSS works by hopping to a new 
frequency each time it transmits or receives a data packet (up to 1600 times per second) to avoid interference 
from other signals.  

When Bluetooth devices come within range of each other, they form an ad hoc network. Each device can then 
perform a query to discover the available services of the other device.  

In order to connect and share services via Bluetooth wireless technology, two devices must support the same 
Bluetooth Profile(s) as well as opposite device roles (i.e., one must be the server, and the other must be the 
client). Bluetooth enabled devices often support multiple profiles, and if involved in multiple connections, 
can perform different device roles simultaneously.  

To provide security, each link is encoded and protected against eavesdropping and interference. Bluetooth 
devices can also request the entry of a matching passkey or Personal Identification Number (PIN) to enable 
access to its services.   

INTRODUCTION  
This chapter discusses how to:   

• Enable/disable the Bluetooth transmitter   

• Making the JETT accessible   

• Configuring Bluetooth services  

BEFORE YOU START  
Before you start, make sure that you enable the Bluetooth device you wish to connect to the JETT and that it 
is set in discoverable mode. You may also need to configure the service you want to use on the device for 
authentication, encryption and COM port assignment  

When frequently exchanging data, it is best to pair the JETT with the other Bluetooth device. This process 
saves the connection information (device name, passkey, etc.) and allows automatic actions (such as 
ActiveSync connections) to occur without operator intervention. Refer to the remote device’s user 
documentation for instructions.   

If you are using authentication, make sure you have any PIN codes or passkeys handy at both devices.  
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BLUETOOTH ICON  
The Bluetooth icon in the system tray provides access to the Bluetooth Control Center. It also indicates the 
state of the Bluetooth transmitter. When the transmitter is active (on), the Bluetooth icon is blue. When the 
transmitter is inactive (off), the Bluetooth icon is gray with a red “X: next to it.   

 

 

Figure 2-1: Bluetooth Enabled  
 

 

Figure 2-2: Bluetooth Disabled  
 

 

BLUETOOTH CONTROL CENTER   
The Bluetooth Control Center (BCC) is an application that manages Bluetooth operation, accessibility, and 
services. You can use the BCC to change the settings for connectability/discoverability/pairing modes, 
authentication/encryption, COM ports, assignments, etc.   

To access the Bluetooth Control Center, tap the Bluetooth icon in the System Tray. The Bluetooth Control 
Center dialog box appears:  

   

The BCC has four tabs: General, Accessibility, Services and About.   

Through the General tab, you can turn the Bluetooth transmitter on of off and access the Bluetooth 
Connection Manager and Bluetooth Pairing Wizard.  

The Accessibility tab allows you to set the device name (as it will appear to devices trying to make a 
connection), make the JETT connectable discoverable to other devices.  

The Services tab enables you to configure File Transfer, Push and Generic Serial service.  

The About tab displays BCC version information.  
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ENABLE/DISABLE THE BLUETOOTH TRANSMITTER   
To enable the Bluetooth transmitter, when its disabled:  

1) Tap the Bluetooth icon in the System Tray. The Bluetooth Control Center (BCC) dialog box opens.  

   

2) Tap the ON button. After the JETT successfully enables the transmitter, it will update the status, 
change the ON button to OFF, and display the device address in the BCC dialog box.  

   

3) After making your selection, tap OK to save your changes and exit the BCC.  

To disable the Bluetooth transmitter, when its enabled:  

1) Tap the Bluetooth icon in the System Tray. The Bluetooth Control Center (BCC) dialog box opens.  

   

2) Tap the OFF button. After the JETT successfully disables the transmitter, it will update the status, 
change the OFF button to ON, and no longer display the device address in the BCC dialog box.  

   

3) After making your selection, tap OK to save your changes and exit the BCC.  
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MAKING THE JETT ACCESSIBLE   
To determine how the JETT interacts with other Bluetooth devices:  

1) Tap the Bluetooth icon in the System Tray. The Bluetooth Control Center (BCC) dialog box opens.  

2) Select the Accessibility tab.  

   

3) Enter a name that uniquely identifies this JETT to other Bluetooth devices. The default value is 
“JETTXL/EYE.”  

4) Check or clear the Discoverable Mode box to make the JETT viewable/not viewable to other 
Bluetooth devices. The default value is discoverable.  

5) Check or clear the Connectable Mode box to allow/prevent other Bluetooth devices from 
connecting to the JETT. The default value is connectable.   

6) After making your selection, tap OK to save your changes and exit the BCC.  

CONFIGURING BLUETOOTH SERVICES  
You can enable and configure the following Bluetooth services on the JETT:   

• File Transfer Service   

• Push Service  

• Generic Serial Service  

CONFIGURING FILE TRANSFER SERVICE  
The File transfer service enables a remote device to connect to the JETT and perform file transfers via FTP.  

To setup the File Transfer service:  

1) Tap the Bluetooth icon in the System Tray. The Bluetooth Control Center (BCC) dialog box opens.  

2) Select the Services tab.  

   

3) If you do not require connected users to enter a username and password, to perform file transfers, 
then check Enable File transfer service.  

4) To require users enter a username and password to perform file transfers, check Authentication and 
then check Enable File transfer service.  
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5) To configure the shared folder or create users, click the Settings >> link that appears next to the 
Enable File transfer service box. The FTP Server dialog box opens.   

   

6) Under User Settings, click Settings. The User Settings dialog box opens.   

7) Tap Add to create a new user. The New User dialog box opens.  

   

8) Type in the Username and Password and then click OK. The User Settings dialog box reopens and 
displays the current users.   

   

9) After entering all your user names and passwords, tap Exit to return to the FTP Server dialog box.  

   

10) To change the shared folder path, change the share path name or setup up authentication for 
everyone, click Settings. The Add Share folder dialog box opens.  

   

a) To change the path of the shared folder: Tap the Browse button. The Select Directory 
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dialog box opens.  

   

By default, the SystemCF folder is the designated shared folder. You can choose an 
existing subfolder from the list or tap Up to select a different folder.   

Warning! If the JETT should lose power, it will only save the contents of the SystemCF folder.  

After making your selection, tap OK. The Add a Share Folder dialog box reappears.  

b) To change the share name, simply type the new share name in the share name box.  

c) To setup authentication for everyone:  

Check the Share this folder for everyone box. An entry for Everyone will appear in the 
Registered users box and a prompt for a Password will appear. If needed, type in the 
password.  

   

11) After making all your selections, tap OK to return to the FTP Server dialog box and then close the 
FTP Server dialog box to return to the BCC Services dialog box.  

CONFIGURING PUSH SERVICE  
The Push Service enables a remote device to receive a vCard from a JETT.   

Note: The JETT does not have a default vCard. You must first transfer a vCard from another device.  

To enable the Push service:  

1) Tap the Bluetooth icon in the System Tray. The Bluetooth Control Center (BCC) dialog box opens.  

2) Select the Services tab.  

   

3) Click the Settings >> link that appears next to the Enable Push Service box. The Push Server 
Settings dialog box opens.   
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4) Tap Browse to select a business card.  

   

5) Tap OK to return to the Push Server Settings dialog box.  

   

6) Tap OK to return to the to the BCC Services dialog box.  

7) Check Enable Push service.  

CONFIGURING GENERIC SERIAL SERVICE  
The Generic Serial service enables a remote device to connect to the JETT for RS-232 based serial 
communications.  

To enable generic Serial service:  

1) Tap the Bluetooth icon in the System Tray. The Bluetooth Control Center (BCC) dialog box opens.  

2) Select the Services tab.  

   

3) Click the Settings >> link that appears next to the Generic Serial service box. The Serial Server 
dialog box opens.   
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4) To authenticate incoming serial service request, check Secure connections.  

5) To change the COM port for serial connection, ensure that you Allow Serial Connection to this 
COM port and then select an available COM port (6 or7).  

6) Close the Serial Server dialog box to return to the BCC dialog box.  

7) Check the Generic Serial service box to enable serial service.  

ACCESSING THE CONNECTION MANAGER   
Before attempting to make a connection with another device, you should make sure that other device is 
Bluetooth ready, "Discoverable" and setup for the service you want to use.  

1) To access the Bluetooth Connection Manager:  

2) Tap the Bluetooth Connection Manager link in the BCC.   

   

3) The Connection Manager wizard appears.  

   

4) Use the scroll bars to find a device/service type to search for and then tap on that device/service to 
begin the connection process.  

GENERIC DEVICE SEARCH   
The Generic Device Search enables you to find all available Bluetooth devices in the immediate area and 
their available services.   

To connect to a device via a generic device search:  

1) Access the Connection Manager wizard and tap the Generic Device Search section. The Find 
Device and Services window appears.   



Appendix C – Bluetooth Configuration 

44 

   

2) Follow the onscreen instructions and then tap Next >> to continue. The Bluetooth Connection 
Manager will then search and display a list of available devices.  

   

3) Select a device and tap Next. The Bluetooth Connection Manager will then search and display the 
device’s services.   

   

4) Select a service and tap Next. The Bluetooth Connection Manager will prompt you to “Add to 
favorites.”  

   

5) If you wish to add this connection configuration to your list of Bluetooth favorites, check the Add 
this connection configuration box   

6) Tap Connect to continue. The Bluetooth Connection Manager will then attempt to make a 
connection.  

   

Note: Your connecting device may request a passkey and/or an acknowledgment to complete the 
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connection.  

7) After making a connection, the Bluetooth Connection Manager will reappear.  

MAKING AN ACTIVESYNC CONNECTION  
This section explains how to setup an ActiveSync connection with a computer   

To connect to a device via ActiveSync:  

1) Access the Connection Manager wizard and tap the ActiveSync Connection section. The Find 
Device and Services window appears.   

   

2) Follow the onscreen instructions and then tap Next >> to continue. The Bluetooth Connection 
Manager will then search and display a list of available computers.  

   

3) Select a device and tap Next. The Bluetooth Connection Manager will then search and display the 
computer’s services.   

   

4) Tap Next to continue. The Bluetooth Connection Manager will prompt you to “Add to favorites.”  

   

5) If you wish to add this connection to your list of Bluetooth favorites, check the Add this connection 
configuration box   
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6) Tap Connect to continue. The Bluetooth Connection Manager will then attempt to make a 
connection.  

   

7) Note: Your connecting device may request a passkey and/or an acknowledgment to complete the 
connection.  

8) After making a connection, the Bluetooth Connection Manager will reappear.  

FILE TRANSFERS   
This section explains how to search and discover devices that support file transfer service and also how to:  

• Send a file  

• Receive a file   

• Delete a file   

• Create a new folder   

MAKING A CONNECTION FOR FILE TRANSFERS  
To connect to a computer to perform file transfers:  

1) Access the Connection Manager wizard and tap the File Transfer section. The Find Device and 
Services window appears.   

   

2) Follow the onscreen instructions and then tap Next >> to continue. The Bluetooth Connection 
Manager will then search and display a list of available computers.  

   

3) Select a device and tap Next. The Bluetooth Connection Manager will then search and display the 
computer’s services.   
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4) Tap Next to continue. The Bluetooth Connection Manager will prompt you to “Add to favorites.”  

   

5) If you wish to add this connection to your list of Bluetooth favorites, check the Add this connection 
configuration box   

6) Tap Connect to continue. The Bluetooth Connection Manager will then display File Transfer dialog 
box, which lists the contents of the connected computer’s Bluetooth Exchange folder.  

   

Note: Your connecting device may request a passkey and/or an acknowledgment to complete the 
connection.  

CHANGING THE LOCAL FOLDER  
Before receiving files from a remote computer, you may want to change the path on the JETT where all the 
received files are stored (i.e., the “local” folder). The SystemCF\Bluetooth folder is the default  local folder.  

To change the path:  

1) On the File Transfer dialog box, select Set Local Folder from the Edit menu.  

   

2) The Select Directory dialog box appears.  
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3) Select a folder from the list or tap Up to select another folder.   

Warning! If the JETT should lose power, it will only save the contents of the SystemCF folder.  

4) After making your selection, tap OK. The File Transfer dialog box reappears.   

5) To end the connection, choose Exit from the File menu.  

RECEIVING FILES  
To receive a file from a remote computer:  

1) On the File Transfer dialog box, select a file or folder and then choose Receive File from the File 
menu.  

   

2) A message box will then appear indicating the completion progress. To stop the transfer, tap 
Cancel.   

   

3) When the transfer is complete, the File Transfer dialog box reappears.   

4) To end the connection, select Exit from the File menu.  

SENDING A FILE   
To send a file to a remote computer:  

1) From the File menu, select Send File.   
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2) The Open dialog box appears.  

   

3) Select a file to send and then tap OK. A progress indicator box will then appear. To stop the transfer, 
tap Cancel.   

   

4) When the transfer is complete, the File Transfer dialog box reappears.   

5) To end the connection, choose Exit from the File menu.  

CREATING A NEW FOLDER   
To create a new folder on the remote computer:  

1) On the File Transfer dialog box, select New Folder from the Edit menu.  

   

2) The New Folder dialog box appears.  

   

3) Type in the name of the new folder and tap OK. After it is successfully created, the new folder will 
appear in the File Transfer dialog box  

   

4) To end the connection, choose Exit from the File menu.  
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DELETING A FILE/FOLDER   
To delete a folder on the remote computer:  

1) On the File Transfer dialog box, select a file or folder to delete and then choose Delete from the File 
menu.  

   

2) To end the connection, choose Exit from the File menu.  

GENERIC SERIAL DEVICE CONNECTIVITY   
The Generic Serial Device Search enables you to find a remote device and establish a serial connection.   

To connect to a remote device and establish a serial connection:  

1) Access the Connection Manager wizard and tap the Generic Serial section. The Find Device and 
Services window appears.   

   

2) Follow the onscreen instructions and then tap Next >> to continue. The Bluetooth Connection 
Manager will then search and display a list of available devices.  

   

3) Select a device and tap Next. The Bluetooth Connection Manager will then search and display the 
device’s services.   
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4) Tap Next to continue. The Bluetooth Connection Manager will prompt you to “Add to favorites.”  

   

5) If you wish to add this connection configuration to your list of Bluetooth favorites, check the Add 
this connection configuration box   

6) Tap Connect to continue. The Bluetooth Connection Manager will then attempt to make a 
connection.  

   

7) Note: Your connecting device may request a passkey and/or an acknowledgment to complete the 
connection.  

8) After making a connection, the Bluetooth Connection Manager will reappear.  

ESTABLISHING A LAN CONNECTION   
This section describes how to connect the JETT to a Bluetooth enabled LAN Access Point (LAP) and browse 
the web pages.   

To connect to a LAP and establish a connection:  

1) Access the Connection Manager wizard and tap the LAN Access Connection section. The Find 
Device and Services window appears.   

   

2) Follow the onscreen instructions and then tap Next >> to continue. The Bluetooth Connection 
Manager will then search and display a list of available devices.  
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3) Select a LAP and tap Next. The Bluetooth Connection Manager will then search and display the 
device’s services.   

   

4) Tap Next to continue. The Bluetooth Connection Manager will then prompt for the entry of a 
username and password.  

    

5) If the LAP has CHAP authentication, you must enter username and password to establish a 
connection and then tap Next to continue. If the LAP does not support CHAP authentication, just tap 
Next to continue. The Bluetooth Connection Manager will then prompt you to “Add to favorites.”  

   

6) If you wish to add this connection configuration to your list of Bluetooth favorites, check the Add 
this connection configuration box   

7) Tap Connect to continue. The Bluetooth Connection Manager will then attempt to make a 
connection.  
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8) Note: Your connecting device may request a passkey and/or an acknowledgment to complete the 
connection.  

9) After making a connection, the Bluetooth Connection Manager will open Internet Explorer and 
attempt to connect to the Internet.  

   

PERSONAL AREA NETWORKING   
This section describes how to setup a JETT to join a Personal Area Network (PAN) and access LAN or WAN 
(e.g., GSM, GPRS, Internet, etc.) resources via a Bluetooth Network Access Point (NAP).   

To connect the JETT to a Personal Area Network:  

1) Access the Connection Manager wizard and tap the PAN Connection section. The Find Device and 
Services window appears.   

   

2) Follow the onscreen instructions and then tap Next >> to continue. The Bluetooth Connection 
Manager will then search and display a list of available devices.  

   

3) Select a PAN device and tap Next. The Bluetooth Connection Manager will then search and display 
the device’s services.   
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4) Tap Next to continue. The Bluetooth Connection Manager will prompt you to “Add to favorites.”  

   

5) If you wish to add this connection configuration to your list of Bluetooth favorites, check the Add 
this connection configuration box   

6) Tap Connect to continue. The Bluetooth Connection Manager will then attempt to make a 
connection.  

   

Note: Your connecting device may request a passkey and/or an acknowledgment to complete the 
connection.  

7) After making a connection, the Bluetooth Connection Manager will reappear.  

DIAL-UP NETWORKING   
This section describes how to search for and connect to a Bluetooth enabled phone.  

To connect the JETT to a Personal Area Network:  

1) Access the Connection Manager wizard and tap the PAN Connection section. The Find Device and 
Services window appears.   

   

2) Follow the onscreen instructions and then tap Next >> to continue. The Bluetooth Connection 
Manager will then search and display a list of available devices.  

   

3) Select a PAN device and tap Next. The Bluetooth Connection Manager will then search and display 
the device’s services.   
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4) Tap Next to continue. The Bluetooth Connection Manager will prompt you to “Add to favorites.”  

   

5) If you wish to add this connection configuration to your list of Bluetooth favorites, check the Add 
this connection configuration box   

6) Tap Connect to continue. The Bluetooth Connection Manager will then attempt to make a 
connection.  

   

7) Note: Your connecting device may request a passkey and/or an acknowledgment to complete the 
connection.  

8) After making a connection, the Bluetooth Connection Manager will reappear.  

HUMAN INTERFACE DEVICE CONNECTIONS   
This section describes how to setup a Bluetooth enabled Human Interface Device (HID), such as keyboard or 
mouse to use with the JETT.   

To connect to a Human Interface Device:  

1) Access the Connection Manager wizard and tap the HID Connection section. The Find Device and 
Services window appears.   

   

2) Follow the onscreen instructions and then tap Next >> to continue. The Bluetooth Connection 
Manager will then search and display a list of available devices.  
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3) Select a PAN device and tap Next. The Bluetooth Connection Manager will then search and display 
the device’s services.   

   

4) Tap Next to continue. In some cases (such as a keyboard connection), the Bluetooth Connection 
Manager will display a screen for added security. In this screen, the Bluetooth Connection Manager 
will display a random PIN, that you can you to pair the HID device.  

   

5) To pair the device, tap Initiate Pairing and then type the displayed PIN on the HID. If you do no 
want to pair the device, just tap Next to continue.  

   

6) If you wish to add this connection configuration to your list of Bluetooth favorites, check the Add 
this connection configuration box   

7) Tap Connect to continue. The Bluetooth Connection Manager will then attempt to make a 
connection.  
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Note: Your connecting device may request a passkey and/or an acknowledgment to complete the 
connection.  

8) After making a connection, the Bluetooth Connection Manager will reappear.  

BUSINESS CARD EXCHANGES   
This section describes how to send, request or exchange business cards (vCards) with other Bluetooth devices 
that provide PIM (Personal Information Manager) services.   

To search for devices to perform a business card exchange:  

1) Access the Connection Manager wizard and tap the Business Card Exchange section. The Find 
Device and Services window appears.   

   

2) Follow the onscreen instructions and then tap Next >> to continue. The Bluetooth Connection 
Manager will then search and display a list of available devices.  

   

3) Select a device and tap Next. The Bluetooth Connection Manager will then search and display the 
device’s services.   

   

4) Tap Next to continue. The Bluetooth Connection Manager will prompt you to “Add to favorites.”  
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5) If you wish to add this connection configuration to your list of Bluetooth favorites, check the Add 
this connection configuration box   

6) Tap Connect to continue. The Bluetooth Connection Manager will then display the Business Card 
Manager, where you can send an object, request a business card or exchange a business card.   

   

REQUESTING A BUSINESS CARD  
To request a business card:  

1) Tap the Request Business Card icon in the Business Card Manager. The JETT will then connect to 
the other device and request a business card file. A pop-up dialog box will appear indicator 
transmission progress.  

   

2) When the transmission is complete, tap OK. The business card file (“.vcf”) is stored in the 
SystemCF\Bluetooth\Inbox folder.  

SENDING OBJECTS  
Note: Since the JETT has now provision to create a contact (i.e., business card), you must first create one on 
another device and either request a business card (see above) or copy it to the JETT before you can a send it to 
another device. In addition, you must enable the Push service.   

To send an object:  

1) Tap the Send an Object icon in the Business Card Manager. The Open dialog box appears.  

   

2) Select a file to send and then tap OK. The JETT will then connect to the other device and send the 
file. A pop-up dialog box will appear indicator transmission progress.  

   

3) When the transmission is complete, tap OK.   
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EXCHANGING BUSINESS CARDS   
Note: Since the JETT has now provision to create a contact (i.e., business card), you must first create one on 
another device and either request a business card (see above) or copy it to the JETT before you can exchange 
cards with another device. In addition, you must enable the Push service.   

To exchange business cards:  

1) Tap the exchange business cards icon in the Business Card Manager. The Open dialog box appears.  

   

2) Select a vCard file to exchange. The JETT will then connect to the other device and send the file. A 
pop-up dialog box will appear indicator transmission progress.  

   

3) When the transmission is complete, tap OK. The business card file (“.vcf”) is stored in the 
SystemCF\Bluetooth\Inbox folder.  

ACCESSING MY BLUETOOTH FAVORITES   
One of the steps in the Bluetooth connection manager wizard is to add the discovered service of a selected 
device as a favorite for quick access the next time you wish to connect to that device and use that service.  

MAKING A CONNECTION  
To make a connection using a favorite:  

1) Tap the Bluetooth Connection Manager link in the BCC.   

   

2) The Connection Manager wizard appears.  

   



Appendix C – Bluetooth Configuration 

60 

3) Tap My Bluetooth Favorites. The Favorites dialog box appears.  

   

4) Double tap a favorite icon. The JETT will then connect to the other device  

   

ACTIVE CONNECTIONS   
You can view a list of all incoming and outgoing active connections by selecting Active Connections from 
View menu.   

 +  

DISCONNECTING AN EXISTING CONNECTION  
To disconnect an existing connection, tap and hold the corresponding icon, then Disconnect in the menu that 
appears.  

PAIRING WIZARD   
The Pairing Wizard enables you to authenticate Bluetooth connections using a secret key.   

PAIRING THE JETT  
To pairing the JETT with another device:  

1) Tap the Bluetooth Connection Manager link in the BCC.   

   

2) The Pairing Wizard starts and the Welcome screen appears.  
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3) Tap Next to continue.  

   

4) Select the device type and tap Next. The Pairing Wizard will begin searching for all devices of the 
selected types within range.  

   

5) Select a device and tap Next to begin pairing. If the Pairing Wizard does not list the device you  want 
to pair, tap the Refresh link to perform another search  

   

6) After establishing a connection, the Pairing Wizard will prompt for the entry of a passkey.  

   

7) Enter the passkey and then tap Next. A corresponding dialog box requesting the same information 
will appear on the connected device. Enter the same passkey on the device to continue.   
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8) If pairing was successful, the Pairing Wizard will display a “Pairing succeeded” message.  

   

9) If pairing fails due to a passkey mismatch, the Pairing Wizard will display a “Pairing Failed” 
message.  

   

UNPAIRING THE JETT  
To unpair the JETT from another device:  

1) Tap the Pairing wizard link in the BCC.   

   

2) The Pairing Wizard starts and the Welcome screen appears.  

   

3) Tap Next to continue. The Paired device list appears.  
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4) Select a device and tap the Unpair link. 
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Appendix D – Wireless Configuration 

ABOUT THE WIRELESS LAN OPTION   
With the Wireless LAN (WLAN) option installed, you can connect the JETT to enterprise and public Wi-Fi 
LAN systems to access the Internet, email and corporate servers.  

For 802.11 networks, the WLAN supports Open or Shared authentication using 40, 64 or 128-bit Wired 
Equivalent Privacy (WEP) encryption keys. These key can be statically associated or dynamically created 
depending on the authentication type.  

The WLAN also supports with networks that use 802.1X authentication with Extensible Authentication 
Protocol-Transport Level Security (EAP-TLS) or Protected EAP (PEAP).  

EAP-TLS and PEAP provide authenticated access to 802.11 wireless networks and minimize wireless 
network security risks by providing user and computer identification, centralized authentication and 
encryption services based on the Wired Equivalent Privacy (WEP) algorithm.   

Note: The WLAN only supports long radio preambles (headers). It will not connect to other access points or 
other WLAN radios that are use short preambles. If you cannot connect to your access point, please check the 
configuration to ensure it is set for long preamble.  

ABOUT THE WLAN SOFTWARE  
Installed on the JETT as part of the Windows CE operating system, The WLAN software consists of two 
components: Wireless Network Connection tools and Client tools.  

The Network connection tools enable you setup, configure and connect to a WLAN, while the Client tools 
perform a variety of utility functions, such as power management and network troubleshooting   

Whenever you turn on the JETT, it will automatically start searching for any wireless network advertising its 
SSID (network name). While searching for wireless networks, the JETT will display the following icons in the 
system tray to indicate the wireless connection status and the connectivity quality.  

CONNECTION STATUS ICONS  
The following icons will appear in the system tray to indicate the wireless connection status. Double tap the 
icon to access the Wireless Network Connection tools.  

Icon  Status  

  Connected to WLAN  

  Disconnected from WLAN  
 

CONNECTIVITY QUALITY ICONS  
The following icons will appear in the system tray to indicate the connectivity quality. Tap the icon to access 
the WLAN Client tools.  

Icon  Status  

  Excellent connectivity  

  Good connectivity  

  Marginal connectivity  

  Poor connectivity  

  No connectivity  

  No quality information available  



  Tracker Xtreme 

  65 

 

802.11 CONFIGURATION REQUIREMENTS  
Before you start, find out what security settings you need to connect to your WLAN network. If applicable, 
consult with the network administrator. The necessary settings may include one or more of the following:  

• Wireless network name (SSID)  

• WEP key, WEP key format (Hex or ASCII) and Key Index number  

• Use of DHCP or Static IP to assign IP addresses  

Note: If using static IP addresses, you must assign the addresses through the WLAGS46B1 Network and Dial-up Connections dialog via 
the Settings menu.  

802.11 CONFIGURATION SETUP  
To configure the JETT to connect to an 802.11 wireless network:  

1) In the Status Bar, double-tap the Connection Status icon to access the Network Connection 
(WLASGS46B1) dialog box.  

   

2) Select the Wireless Information tab.  

   

3) Double-tap the SSID (name is case-sensitive). If the name does not appear, double-tap Add New. In 
either case the Wireless Properties dialog box appears.  

   

4) If needed, enter the Network name or SSID (case sensitive).  

5) If using Open authentication without WEP encryption, select Disabled as the Encryption type.  

6) If using Open or Shared authentication with WEP encryption:  

a) Select the appropriate authentication type: Open or Shared.  
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b) Select WEP as the Encryption type   

c) Clear the Key is provided to me automatically box.  

d) Enter the WEP key. For 40/64-bit keys, use either 10 hex digits or 5 ASCII characters. For 
128-bit keys, use either 26 hex digits or 13 ASCII characters.  

e) Enter the Key index number.  

f) Clear the Enable 802.1X authentication box.  

7) Tap Ok to exit the Wireless Properties dialog box. The Wireless Information dialog box reappears. 
The JETT will then begin to scan for the selected network and attempt to make a connection.   

8) If the connection was successful, the icon for the selected network will appear with a blue halo.  

   

9) Tap Connect to Ok to exit the WLASGS46B1 dialog box.  

To verify that you have a successful network connection, launch Internet Explorer and type in the AP’s 
IP address. The AP’s Summary Status page should appear.  

   

802.1X CONFIGURATION REQUIREMENTS  
This section describes how to install the certificates on the JETT required for PEAP or EAP-TLS 
authentication, as well as configure and connect the JETT to a 802.1X network.   

Before you start, find out what security settings you need to connect to your WLAN network. If applicable, 
consult with the network administrator. The necessary settings may include one or more of the following:  

• Wireless network name (SSID)  

• Authentication type, user name and password  

•  Use of either DHCP or Static IP to assign IP addresses  

• Authentication permission restrictions (e.g., domain administrators only)  

• A copy of the root certificate from a Trusted Root Authority (no intermediary authority)  

Note: If using static IP addresses, you must assign the addresses through the WLAGS46B1 Network and Dial-up Connections dialog via 
the Settings menu. 
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INSTALLING CERTIFICATES  
Before you can connect to an 802.1X network, you will need to install the Root CA certificate of your network 
CA into the Trusted Root CA store on the JETT. To do this, you or your network administrator must export 
the certificate from the CA and make it available for installation on the JETT using an ActiveSync connection 
ors a copying it from a Compact Flash card.  

If your network uses EAP-TLS authentication, you also need to install a user (client) certificate.  

INSTALLING ROOT CERTIFICATES  
To install root certificates on the JETT:  

1) Using either an ActiveSync connection or Compact Flash card, copy the root certificate into the My 
Documents folder on the JETT.  

2) On the JETT, tap the Connectivity Quality icon that appears in the system tray.  

   

3) The WLAN Client Tools dialog box appears.  

   

4) Tap Advanced then View Certificates…  

   

5) The Certificate Enrollment wizard appears.   

  

6) Tap Import… The Open dialog box appears.  
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7) Navigate to the My Documents folder, select the root certificate and tap OK. The JETT will then 
prompt you to add the certificate to the Root Store.  

   

8) Tap Yes to continue. A confirmation message will then appear and indicate the addition of the 
certificate to the Root certificate store.   

   

9) Tap OK to return to the Certificate Enrollment wizard. Select Root from the Store drop-down list to 
verify the addition. The new certificate should now appear.  

   

10) Tap OK to exit.   

INSTALLING USER (CLIENT) CERTIFICATES  
If you are connection the JETT to a 8021.X network that uses EAP-TLS authentication, you will need to install 
a user (client) certificate via an ActiveSync connection between the JETT and the Certification Authority 
server.   

Note: Before starting this procedure you should maximize the desktop area of the JETT by selecting the Taskbar and Start Menu 
Properties from the Start menu and clearing the Always on top check box.  

To install a user (client) certificate for EAP-TLS authentication:  

1) Establish an ActiveSync connection between the JETT and the Certification Authority server.  

2) On the JETT, tap the Connectivity Quality icon that appears in the system tray.  

   

3) The WLAN Client Tools dialog box appears.  
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4) Tap Advanced then Enroll…  

   

5) The Certificate Enrollment wizard appears.  

   

6) Tap Next.  

  

7) Enter the User name, Password and Server name, and then tap Next. When entering your user name 
use the format: domain\username. The JETT will then request the certificate from the Certificate Authority 
server.   

8) After the JETT indicates the successful receipt of the certificate, tap Finish to complete the process 
and exit the wizard.  

   

9) Disconnect the Active Sync connection. You are now ready to connect to the network.  
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802.1X CONFIGURATION SETUP  
To configure the JETT to connect to an 802.1X wireless network:  

1) In the Status Bar, double-tap the WLAN icon to access the WLASGS46B1 dialog box.  

   

2) Select the Wireless Information tab.  

   

3) Double-tap the SSID (name is case-sensitive). If the name does not appear, double-tap Add New. In 
either case the Wireless Properties dialog box appears.  

   

4) Select WEP as the Encryption type.   

5) Select Open as the Authentication type.  

6) Check the Key is provided to me automatically box.  

7) Check the Enable 802.1X authentication box.  

8) Select the EAP type: TLS or PEAP.  

9) Tap OK to exit the Wireless Properties dialog box and return to the WLASGS46B1 dialog box  
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10) Select the network name and tap Connect. While attempting authentication, the JETT and display a 
User Logon dialog box.   

a) For TLS authentication, enter the user name and domain, and then tap OK.  

   
b) For PEAP authentication, enter the user name, password and domain, and then tap OK.  

   

11) If the connection was successful, the icon for the selected network will appear with a blue halo.  

   

12) Tap OK to exit the WLASGS46B1 dialog box.  

 To verify that you have a successful network connection, launch Internet Explorer and type in the AP’s IP 
address. The AP’s Summary Status page should appear.  
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ABOUT THE WLAN CLIENT TOOLS   
The WLAN Client Tools is a set of utility functions that enable you to perform the following tasks:  

• Enabling/disabling the radio  

• Power Management  

• Suspension of WLAN while connected  

• Create and view the log file  

• Display Version information  

In addition, a set of advanced tools enables you to perform network troubleshooting, monitor site activity 
and manage certificates (discussed previously).  

To access the standard WLAN Client Tools:  

1) Tap the Connectivity Quality icon to display the WLAN Client Tools dialog box.  

   

2) The WLAN Client Tools dialog box appears.   

   
3) Tap Tools to display the standard WLAN Client Tools menu.  

  

ENABLE/DISABLE RADIO  
If needed, you can enable or disable the radio as follows:  

1) Access the standard WLAN Client Tools menu.  

   

2) If enabled, check Disable Radio to turn off the radio. If disabled, check Enable Radio to turn on the 
radio.   
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POWER MANAGEMENT  
For energy efficiency, you can enable the card’s power management option.   

1) Access the standard WLAN Client Tools menu.  

  
2) Select Power Management and then select either On to enable power management or Off to disable 

power management.  

SUSPEND WHILE CONNECTED  
To optimize battery life, you can allow the JETT to suspend according to its power settings whenever the 
WLAN card is connected and there is no data traffic. However, if the JETT suspends while connected to the 
WLAN, the connection will be dropped.   

1) Access the standard WLAN Client Tools menu.  

   

2) Clear Suspend While Connected to run the wireless option continuously.  

3) Check Suspend While Connected to allow the JETT to suspend according to its power settings 
whenever the WLAN card is connected and there is no data traffic.   

4) In either case, a message will prompt you to reset the JETT. Tap OK to continue.   

LOG FILE  
To help troubleshoot connection problems, you can view the connection log. This log is a snapshot of a 
connection at the time you enable the log.  

1) Access the standard WLAN Client Tools menu.  

   

2) Tap Log.   

3) When a confirmation message appears, tap OK to clear the message.  

4) Open My Computer and double-tap wireless.txt to view the log in Pocket Word.  
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VERSION INFO   
To view version information about the WLAN option:  

1) Access the standard WLAN Client Tools menu.  

  
2) Check Version Info. The Version Info window will appear.  

   

3) Tap OK.   

ADVANCED CLIENT TOOLS  
The advanced Client Tool enables you to perform network troubleshooting, monitor site activity and manage 
certificates (discussed previously).  

To access the advance WLAN Client Tools:  

1) Tap the Connectivity Quality icon to display the WLAN Client Tools dialog box.  

   

2) The WLAN Client Tools dialog box appears.   

   
3) Tap Advanced to display the Advanced Tools menu.  
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NETWORK TROUBLESHOOTING  
To perform network troubleshooting:  

1) Access the Advanced Tools menu.  

  

2) Tap Network Troubleshooting. The Network Troubleshooting dialog box will appear, displaying 
the IP address assigned to your JETT.   

   

3) Note: If you have an ActiveSync, connection to your host PC, two IP addresses will appear.   

4) To test network connectivity, select or enter the IP address of the target device, and then tap Ping. A 
pop-up message will display the results.  

   

5) To view Advanced IP information, tap Advanced.  

   

6) Use the scroll bars to review the data at the bottom of the screen.   

7) After reviewing the data, tap OK to return to the Network Troubleshooting dialog box.  

8) To request a new IP Address, tap IP Renew.   

  

9) If updated, the Network Troubleshooting screen should display a new IP address.  
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10) Tap Close to return to the Network Troubleshooting dialog box.   

11) Tap OK to exit the Network Troubleshooting screen.   

SITE MONITOR   
Use the Site Monitor option to check the signal qualities of WLAN networks within range.  

1) Access the Advanced Tools menu.  

  

2) Tap Site Monitor. The Site Monitor dialog box will appear and list any WLAN networks detected in 
range.   

   

3) To view information about a network, tap the network name. A screen will appear reporting the 
MAC address, SNR (Signal-to-Noise Ratio), Signal, and Noise of the WLAN network.   

   

4) Tap Back to return to the previous screen   

5) Tap OK to exit the Site Monitor screen.  

Using WiFi and ActiveSync 
ActiveSync is a desktop utility program (available as a free download from Microsoft) that allows you to 
synchronize certain types of information between a PC and the JETT. You can also use ActiveSync to transfer 
files and install programs on the JETT. To create a wireless ActiveSync connection, you must first create a 
partnership between the JETT and the PC.  

Important Note: You must use ActiveSync 3.8 to create a WLAN remote PC link. ActiveSync 4.0 or above only supports a wireless remote 
PC link via Bluetooth; it does not support a remote PC link via WLAN.  

SETTING UP YOUR NETWORK CONNECTION  
In order to setup a network connection, the WLAN card in your PC must be setup to use “Internet Protocol 
(TCP/IP).” If you are manually specifying an IP address, make sure that you are using NetBIOS over TCP/IP. 
If you are you using a DHCP router or server to assign IP addresses automatically, make sure you are using 
NetBIOS over TCP/IP.  

For more information about your PC network connection settings or setting up your PC to use a TCP/IP 
network connection, consult your system administrator or refer to Windows on-line help.  
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CONFIGURING THE JETT  
To setup initial communication between the PC and the JETT, you must first configure the JETT with the 
correct communication setting.  

1) Connect one end of your interface cable to an available COM or USB port on your desktop computer. 
Connect the other end of the cable to the JETT.  

2) On the JETT, tap Settings> Control Panel > PC Connection. The PC Connection Properties Dialog 
box appears.  

   

3) Verify your PC Connection type: “PC-115” for serial cable connection or “USB_Serial” for USB cable 
connections.  

4) If you need to make a change, tap Change Connection. The Change Connection dialog box appears.  

   

5) Select the correct setting from the drop-down list and tap OK. The PC Connection Properties Dialog 
box reappears.   

6) Tap OK to exit.  

7) Close the Control Panel and return to the JETT desktop.  

CONFIGURING THE PC  
After you configure the JETT, you must configure the PC before making an ActiveSync connection.  

Note: If you are installing ActiveSync on the PC for the first time and the Get Connected wizard appears, click Cancel.  

1) On the PC, start ActiveSync.  

   

2) On the ActiveSync menu bar, select File and then Connection Settings. The Connection Settings 
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dialog box opens.  

    

3) Depending upon your connection type, ensure that you have the correct connection type enabled 
(Serial or USB). If you are using a serial cable connection, make sure you select an available COM 
port (for example COM1), then click Get Connected. The Get Connected wizard opens.  

   

4) Click Next. ActiveSync will then attempt to connect to the JETT.  

   

5) On the JETT desktop, tap PC Link.   
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6) The following message box appears:  

   

7) If ActiveSync successfully establishes communications, the ActiveSync dialog will briefly reappear 
on the PC and start the New Partnership dialog wizard.   

CREATING A PARTNERSHIP  
To create a partnership during your initial setup:  

1) When the New Partnership wizard appears, select Yes.   

   

2) Click Next. ActiveSync will then prompt you to select the type of information you want to 
synchronize.   

   

3) Check or clear the boxes that pertain to the type of information you want to synchronize.  

Notes: In order to synchronize files, you must enable the Files settings. The JETT does not support Pocket Access or the 
synchronization of Pocket Access files  
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4) When choosing to synchronize files, the following message will appear:  

   

5) Click OK to continue. The New Partnership wizard reappears. Click Next.   

   

6) Click Finish to complete the wizard. the ActiveSync dialog box will reappear as follows:  

   
On the JETT, an icon indicating a ActiveSync connection will appear in the system tray.   
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MAKING A REMOTE PC LINK  
To make a remote PC link:  

1) Make a network connection.  

   

2) On the JETT desktop, Tap Start and select Programs > Communications > PC Link Remote. The 
ActiveSync dialog box opens.  

   

3) From the Connect to drop down list, select the name of the PC you are linking. The JETT will then 
attempt to establish a connection, automatically update any out-of-date items and synchronize with 
your desktop folder.  

      

4) Tap Sync Now to update your folders manually.   

5) Tap Disconnect to terminate the connection.  
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Appendix E – Tracker Xtreme User Tips 

This guide has been prepared to help you get the best performance from your Tracker Xtreme and also to help 
you fix some issues that might appear from time to time. 

 

Battery Life 
The Tracker Xtreme comes standard with a 2500 mAh battery.  Average run times will vary depending on 
many different factors but on average you should expect 12 – 16 hours of use. 

Hardware Settings - To help increase your battery life you should review the following settings on your 
Tracker Xtreme. 

1. Wireless Radio – If you do not need to use the built-in wireless radio we suggest you disable it to 
conserve power.  The Wi-Fi radio is very power demanding and can decrease the battery life to as 
little as 5 hours.  Please refer to the Wireless Radio section for more details. 

2. Bluetooth Radio - If you do not need to use the built-in Bluetooth radio we suggest you disable it to 
conserve power. Using the Bluetooth radio will decrease the battery life by 10% – 20%. Please refer 
to the Bluetooth Radio section for more details. 

3. Backlight Brightness – We suggest you adjust this to a 25% brightness level to conserve power. In 
some situations you can turn the backlight off which can have a significant impact on battery life.  
Please refer to the Backlight Brightness section for more details.  

4. Keypad Backlight – If your Tracker Xtreme has a backlit keypad, we suggest you turn off the 
backlight when it is not needed to conserve power.  In some situations you can turn the keypad 
backlight off which can have a significant impact on battery life.  Please refer to the Backlight 
Brightness section for more details. 

5. Power Suspend Mode – We suggest you adjust these to help the Tracker conserve power. Please 
refer to the Power Suspend Mode section for more details. 

Environmental Factors – Temperature can have a significant impact on battery life.  In extreme cold 
temperatures, battery life can decrease by as much as 50%. 

 

Wireless Radio 
Your Tracker Xtreme is shipped with a built in wireless (Wi-Fi) radio.  When this radio is enabled, upon 
power up you will see a screen appear allowing you to select a wireless network. 

 

It is important to note that if the box “Notify when new networks are available” is unchecked it will not 
disable the wireless radio.  All it does is stop the wireless radio from notifying you when new wireless 
networks are found.  If you do not need to use the wireless radio we suggest you turn it off.   
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Instructions for Turning off the Wireless Radio 
To turn it off go to Start | Settings | Control Panel | Aux Switch.  In the Aux Switch screen, set the 
Power-Up and Test options to Off. 

 

Next go to Start | Settings | Control Panel | AuxCF Slot.  In the AuxCF Slot Properties screen, set the 
Power-Up State to Disabled. 

 

Once these settings are changed you need to warm boot the Tracker before the changes take effect.   

 

  

 

 

If you see this icon, it 
indicates that the wireless 
radio is on.  If you’ve 
disabled the radio 
successfully, you should not 
see the “tower” icon. 
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Bluetooth Radio 
Your Tracker Xtreme has a built in Bluetooth radio.  The status of your Bluetooth radio can be determined by 
the Bluetooth icon on your taskbar.   

A gray icon with a red “x” indicates that the Bluetooth radio is turned off. 

A solid blue icon indicates that the Bluetooth radio is turned on. 

 

You can also get the status by tapping on the Bluetooth icon in the taskbar which will open the Bluetooth 
manager.  Here you will see the status as being either On or Off. 

 

If you do not need to use the Bluetooth radio we suggest you turn it off. 

Instructions for Turning off the Bluetooth Radio 
1. To turn the radio off, simply tap the Bluetooth icon on your taskbar.   

2. Once selected you will see the Bluetooth Manager screen. 

 

On this screen press the OFF button. 

3. You should now see the following: 

 

A Bluetooth status of OFF 
indicates that the radio is 
disabled. 
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Backlight Brightness 
You can control the backlight brightness on your Tracker Xtreme.  This setting can have a significant impact 
on battery life and we suggest you set it to 25% active and 0% inactive when using the battery.   

To set or check your backlight brightness settings do the following: 

1. Go to Start | Settings | Control Panel. 

2. In Control Panel select the Backlight option. 

 

3. In the Backlight Properties screen set the Battery Active setting to 25, and set the Battery Inactive 
setting to 0. 

 

Note:  In some situations you can turn the backlight off (Battery Active 0%) which will drastically 
improve battery life.   

4. If your Tracker has a backlit keypad, you may also want to turn off the keypad backlight in some 
situations to improve battery life.  In the Backlight Properties screen, uncheck the “Enable Keypad 
Backlight” option. 
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Power Suspend Mode 
You can control the time it takes your Tracker to switch to different power save modes.  Using these options 
can improve your battery life. 

 

1. Go to Start | Settings | Control Panel. 

2. In Control Panel select the Power option. 
 

 

 

3. In the Power Properties screen click on the Schemes tab.  In the Schemes page select the Battery Power 
Scheme from the drop down menu.  We suggest you use the following settings: 
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Taskbar Auto Hide 
The FieldGenius and Evidence Recorder interfaces have been designed to use the entire screen.  Prior to 
shipment, we change a setting that forces the taskbar to disappear.  Your FieldGenius or Evidence Recorder 
screen should look like this. 

 

If you reset the registry in the Tracker, it will revert back to the default factory settings which are to always 
show the taskbar.  When this happens, the bottom screen in FieldGenius or Evidence Recorder will be 
covered by the taskbar. 

 

 

Instructions to Hide the Windows Taskbar 
1. Go to Windows Start | Settings | Taskbar and Start Menu. 

2. In the Taskbar and Start Menu Properties screen, turn on the “Auto hide” option. 
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